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Preface

This user manual describes how to install and operate the SmartAlign image registration and
scan-distortion compensation plug-in (version 1.x) for Digital Micrograph. The software is based

on the full-length manuscript by Dr Lewys Jones and Prof Peter D. Nellst:

Jones, L., et al.. “Smart Align—a new tool for robust non-rigid registration of scanning
microscope data”. Advanced Structural and Chemical Imaging, 1 8 (2015). Link

As this tool applies post-processing steps to experimental data, users should state explicitly

when such steps have been applied by citing the above paper such as:

“image alignment and scan-distortion compensation was performed using the SmartAlign
software described in [1]”.

Most of this manual describes the processing of atomic resolution image series acquired in the
scanning transmission electron microscope (STEM), however the same steps apply to data from
the scanning tunneling microscope (STM) and the atomic force microscope (AFM). A separate

section at the end of this manual describes settings specific to these physical probe techniques.

Contact

Enquiries regarding sales, licensing, installation and operation of the plug-in should be directed
to:

support@hremresearch.com

For questions about the academic manuscript referenced above, please contact Dr Lewys Jones
at:

lewys.jones@materials.ox.ac.uk

Copyright Statements

© Copyright 2015-2016 HREM Research Inc.
All rights reserved. This manual is protected by international copyright laws and treaties.
Unauthorized reproduction and distribution of this manual, or any portion of it, will be

prosecuted to the maximum extent possible and may result in severe civil and criminal penalties.

DigitalMicrograph is a trademark of Gatan Inc.
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When to use this Plug-in

The SmartAlign plug-in for Digital Micrograph is designed to correct the most common image
distortions encountered in atomic-resolution image series recorded in the scanning transmission
electron microscope (STEM), including image drift between frames and scan-distortion within

each frame. These are shown schematically below:

Image Drift Scan-noise
[1-4] [5] [2,9]
Distortion ] 1 _
o T T T T T T >
Frequency Hz
0 0.1 1 10 100 1,000 10,000
Correction Affine Super-local
Methodology Transform Transform
Image 50Hz (pixel-wise)
Translation Line-sync

Image distortion frequency domains. For a description of the references above, please see the
associated academic manuscript (Jones et al., 2015).

SmartAlign is used to correct image-drift and scan-distortion. Scan-noise however, caused by
instabilities up in the kHz regime, can be corrected using the Jitterbug plug-in also available from

HREM Research (Jones & Nellist, 2013).

Image offsets between frames in a series are readily identifiable. These can be easily corrected
to simply the analysis of time-series or focal-series data. Scan-distortion can appear as additional
image transformations, including affine transformations (stretch, skew / shear, small rotations)

and non-linear distortions, causing otherwise straight crystal lattice planes to become ‘wavy’.

If your data includes these types of shifts and/or distortions, then it may be possible to recover
some or all of the lost performance caused by scan-distortion. Of course if the image is very
heavily degraded it will not be possible to compensate this entirely. Equally this plug-in cannot
create resolution that did not exist prior to the incorporation of scan-noise. For further

information and some related reading please see the reference given on page 2.
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Installation

Software Requirements

The following is a list of the software requirements necessary to run the SmartAlign plug-in:

. DigitalMicrograph (GATAN™) with DigiScan and EMControl

i USB Key Driver

. HREM Mouse Tool Plug-in (Free-ware downloadable from www.hremresearch.com)
. IPU Plug-in (Free-ware downloadable from www.hremresearch.com)

. Acquire Image Series (Free-ware downloadable from www.hremresearch.com)

. Matlab MCR (Matlab Compiler Runtime) v8.2.

Software Installation

Installing USB Key Driver
The user key driver should be installed by following the instructions given by the key driver

installer. The key driver installer can be found on our web site.

Installing SmartAlign Plug-in
The plug-in can be installed by drag-and-drop copy to the folder “Pluglns” (The Pluglins folder

should exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglins folder,

SmartAlign menu commands will appear under “SmartAlign” menu.

Installing Mouse Tools Plug-in, IPU Plug-in and Acquire Image Series Plug-in
All the files relating these tool plug-ins, can be installed by drag-and-drop copy to the folder

“Pluglns.” (The Pluglns folder should exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Plugins folder, the

Mouse tool will appear as an addition to the standard tools.

Installing Matlab MCR
The Matlab MCR should be installed by following the instructions given by the installer. The

Matlab MCR that is compatible with the SmartAlign can be found on our web site.




SmartAlign Plug-in User Manual

Typical Workflow

The SmartAlign software is very flexible in how it is used, however, most tasks will follow a
similar workflow. These are summarized below and then discussed in more detail in the

following sections.

® The first stage is the recording (or loading) of an image

Data series.
acquisition

® This stage prepares the image-series for processing, is
Data used to trim the series, adjust the pixel-sampling and

preparation

setup the options corresponding to different
acquisition conditions.

Ri d ®  Rigid-registration removes the translation offsets
! 18] . between images in the series caused by stage /
reglstratlon sample drift.

® Non-rigid registration removes the affine and/or non-
Non—rlgld linear distortions within each frame.

registration

®  For drift measurement and compensation (optional)

Second image the lattice base vectors must be identified. These
: directions will also be used for and image line-profiles
or Sl correction used.

The plug-in is designed so that each stage in the processing creates a new data window for its
results. If for some reason the calculation fails, or the user wants to go back one stage and
choose a different setting, the new window can simply be closed and the result from the

previous stage will still be there.

The following examples will use the supplied example image-series of a SrTiO; nano-cube edge

to demonstrate the various steps.
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Plug-in Menu

The figure below shows the default menu for the SmartAlign plug-in:

Filters | SmartAlign | Help

°.° @ Acquire... ‘Q

Setup Stacked Image from Archived Data...

Prepare Data...
Rigid Alignment...
Non-rigid Alignment...

Align Second Signal...
Align SI Data...

Remove Image Ramp
Crop Data
Show as Movie

Remove NR translation data

Help
About...

Supported File Types

To begin, the user should have the file open within the Digital Micrograph workspace. To open a
file either open it from your computer or from within DM by going to File > Open. DM supports
images-series being saved as a single file (as slice data), however if the images were recorded as

’

separate files, they can be imported using the ‘File’ > ‘Open Series...” option to produce the

stacked data on import.

The plug-in supports all image formats supported by DM, however, it is strongly advised that the

images to be processed have received no image compression (such as JPEGs).
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Data Acquisition

A tool for the recording of series is included with SmartAlign.

= -
gz Smart Align Acquisition |

Control I Signal ]

Data Name: |Test

Number of Images: IT
(") Save each image to disk
() Create stacked image
(@) Create stacked image and save numbered ll—
Folder: I C:\Folder_Name

Browse Folder Directory ]

Maanification: | 100000.0

Image Dimensions: | 512

Pixel Dwell Time (us): |40—
Image Rotation: lr ["]90 Degree Rotation
[ Line Synch
[V]Rigid Alignment for [0:JEOL ADF1 v | [ setup |
["] save aligned stack to disk

["] save aligned average to disk

OK ] [ Cancel

‘Control’ Tab

Data Name
Here you can enter a filename that will assigned to the recorded image series. If the user
chooses to create a stacked image (see next section), and use the auto-numbering and save
feature, each filename will be created using underscores to concatenate the fields with the

following format:

“ n “ on

“Data Name” + + “Sequential Number” + + “Detector Name”

For example:

My Sample Name_001_JEOL ADF1
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If you change to a new sample / region / experiment you can choose a new ‘data name’ and
reset the numbering by simply typing the next desired number. Numbers are given in a three

digit format.

Number of Images
This specifies the number of images in the series. After recording, the series can always be
trimmed. If the stability or damage tolerance of the sample is unknown, it may be helpful to
overestimate the desired number of frames. If damage or contamination is observed, then the

user can later decide to reject the later part of the series.

In addition to specifying the number of images, the user should choose whether to write the
images individually to disk or to display the images as a single stack (as slice data). In general, a
single stacked image is more convenient. However, if recording very large images, or an

extremely large number of frames it may be preferable to write directly to disk.
In the case of creating a stacked image, the user can further select to auto-save this file.

Folder
If an auto-saving option was selected, then images will be saved into the specified folder. Either

type to location directly or select the folder using the ‘Browse’ button.

Magnification
This will be automatically read from the microscope and added to the image series meta-data.
This does not need to be edited unless the user changed the magnification after opening the

acquisition menu.

Image Dimensions
This will be the height and width of the image measured in pixels. The recorded images are

square.

Pixel Dwell Time
This sets the dwell-time for each pixel in units of microseconds. The time for one scan-line will
be the image width multiplied by this number. To adjust other time parameters such as the

flyback waiting time, use the advanced settings in the normal STEM Digiscan dialogue window.

Image Rotation
This sets the overall rotation of the scan, performing the same function as ‘scan-rotation’ in the
Digiscan settings. The scan-rotation of acquired data has an effect on the ease of processing the

series.

10
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For the rigid registration, the image alignment will make use of correlations calculated in
Fourier-space (more details later). To maximise the precision of this stage it is advisable to
ensure that when recording image series, the Fourier spots (including their cross shaped streaks

from the finite image border) do not impinge upon one another.

For the non-rigid registration, if a low-order crystal lattice plane is aligned to the fast-scan
direction, then often some scan-rows will contain only minimal contrast. As it is image contrast
which is used to identify and correct for the scan-distortion, it is preferable for scan-rows to not

be devoid of contrast.

Both of these conditions can be fulfilled by adding a small scan-rotation off of the crystal plane

(say 10° or so).

A further robustness to sample / stage drift can be incorporated by adding an additional scan-
rotation stepping of 90° between each image frame. In this case the images will be rotated back

when added to the stack.

Auto Rigid Alignment on Finish

If selected, an automated rigid registration can be performed immediately after the acquisition
has finished. This will only correct for image translation (whole frame offsets), however it allows
the images in the series to be summed for inspection. The user can then check, for example, the

sample tilt or image defocus.

If this option is selected, then one signal can be selected as the inspection signal. Other signals
can be registered later. The ‘Setup’ button allows for the rigid-registration settings to be

adjusted.

To maximise workflow productivity, the outputs from this post-acquisition alignment can be
immediately saved to disk, with the option to also save the average through the series as a single

frame.

11
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‘Signal’ Tab
On this tab the user can select the signals to be recorded. If multiple signals are selected these
will be recorded simultaneously. Importantly, this means that the same probe-offset vectors will

apply to every signal.

In this tab the number of signals available to the Digiscan, as well as their names, will be

automatically detected.

o N
g~ Smart Align Acquisition @

Control Signal I

Output Signal: V] 0:JEOL ADF1 4byte ¥
[T]1:JEOL ADF2  |4byte
(] 2:JEOL BF 4byte ¥
"] 3:GATANBF/DF |4byte +

(7] 4:Pulse 0 4byte

(7] 5:Pulse 1 4byte ¥

oK ] [ Cancel

12
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Data Preparation

The data preparation stage should be executed before any either of the registration stages:

Data Preparation | Rigid Registration | Non-Rigid Registration I Display | Advance
[]select frame sub-set

First frame: |1 v

Last frame: 17 v

[Jreverse frame sequence
[] transpose data in x-y
Normalise dynamic-range of data

[JResample data: [ 2.0

Scan-rotation (90deq) between each frame: None v
Scan-ine time: |0.02 seconds; (for frequency calibration only)
Median equalise data (STM/AFM only): | Off v
OK Cancel
Data Shaping Options

In this menu the user can choose to select only a sub-set of the frames in the series. To do this
select the checkbox and then choose the first and last frame number (note frame counting here

is one based and not zero based).

The user can also select to reverse the frame order; this may be useful when processing or

comparing focal series.

The user can select to transpose data; this may be useful if the data has been imported from an

FEI *.ser file or from another package such as MatLab.

13
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Data Scaling Operations

Normalising the Data Grey-level Range
For most applications the numerical values of the STEM image pixels are not needed. In this case
the data may be scaled (subtracting some constant and dividing by another) with no loss of

qualitative information or relative contrast.

There are two reasons why the user may want to do this; for data with a large constant offset
(for example a large amplifier black-level) the data will have a large mean grey-level. This will
give a large DC offset in the Fourier based cross-correlations used for rigid registration.
Subtracting a constant reduces this offset term and may help with the rigid registration.
Additionally, the later non-rigid registration calculation is based on image intensity gradient

matching and dividing the range of the data by a constant may accelerate the calculation speed.

Note, if performing a quantitative analysis, where the pixel intensities do have real meaning, this

option should not be used.

Data Resampling
This option allows the user to resample the data in x-y before any onward processing.
Resamplings smaller than one will reduce the number of pixels in the image (more coarse
sampling), and values larger than one will increase the number of pixels in the data (more fine
sampling). Reducing the sampling may be useful for condensing data from large CCD cameras or
to do initial quick calculations on less powerful computers. Increasing the sampling may be
useful to achieve digital super-resolution. In general, increasing the sampling by more than, say,
three or four will not lead to any improvement but will slow the subsequent calculations

significantly due to increased memory usage.

Digital super-resolution is an advanced topic and a separate example is given at the end of this

manual.

Scan Metadata Options

Scan Rotation Between Frames
This option toggles different modes in SmartAlign depending on how the image series was

recorded. Specifically, it changes the ‘row-locking’ and ‘row-fitting’ behavior used in the non-

14
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rigid registration options. Users should see the associated manuscript for a further description of

the ‘row-locking’ and ‘row-fitting’ behaviours.

Scan-rotation (90deq) between each frame:

Scandine time: | 0.02 seconds; (for freforizontal scan first

Vertical scan first

The default setting is ‘None’, this means that no change in scan-rotation was used during the
experimental acquisition. Alternatively, SmartAlign can accept data with multiples of 90° scan-
rotation change between frames. For this data can be recorded as ‘orthogonal pairs’, that is
scanning at 0°, 90°, 0°, 90°... etc., or as an ‘orthogonal set, i.e. 0°, 90°, 180°, 270°, 0°, 90°... and so

on.

If either orthogonal type option is used, then the user should select whether the fast-scan
direction is horizontal or vertical in the first image of the series after any trimming of the series

and/or transposing has been applied from the earlier options.

Scan-line Time
Here the user can specify the time per fast-scan line. This is only used to calibrate the frequency

axis in the instability frequency analysis.

Median Equalisation (Tip Height Correction)

This is an advanced option which attempts to correct for STM/AFM tip height errors.

Median equalise data (STM/AFM only):

Row-wise medians
Global median

For STM/AFM image series exhibiting tip-height errors, the data can be adjusted in height to

bring each scan-row onto either a row-wise median, or global median height.

The default mode for STEM or TEM imaging is ‘Off’. The only exception to this would be for
STEM data recorded with a cold-FEG gun where the emission fluctuation compensation has

failed (but this is very rare).

15
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Rigid Registration

Selecting the Area for Rigid Registration
The Smart Align software can perform the rigid-registration in one of two ways; either on the

entire field of view, or on a selected ‘region of interest’ (ROI).

Full field-of-view (without ROI):

To use the full field of view, simply select the pre-processed data as the front window and then

select “Rigid registration” from the Smart Align menu.

&k F: Preprocessed 12cm - RevSTEMI0 ADF2

>

Using the entire image will yield an aligned image with the biggest possible field of view, but it
may take longer to compute. For low-dose data, where crystal fills the field-of-view, then using

the whole area is likely to increase alignment precision.

16
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ROI Alignment
To use the ROI alignment mode, first draw a ROl on the pre-processed data using the DM ROI

tool:

% Digital Micrograph
! File Edit Display Process Analysis Window Microscope
N2 TR AN H =,

Histogram v X

You should ensure that the ROl is large enough to fully encompass the feature of interest in ALL
slices of the series data, not just in the first slice. You should inspect the slices before proceeding

to ensure that the ROl is large enough to include the feature after sample/stage drift.

5 F: Preprocessed 12cm - RevSTEM30 ADF2

9

Where only one region of an image is of interest, then using a ROI rigid-align will generally be
faster. This may also be useful if trying to align very large datasets where memory use would be

an issue and a fiducial mark is present (see special FIB-SEM example at end of manual).

A hybrid of these approaches is to measure the image shifts on the smaller ROl data but then to
correct the image shifts on the full field-of-view; see the later section on “Aligning Extra Image

Signals”.

17
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Selecting the Rigid Registration Options
Each experimental dataset is unique; the rigid-registration menu contains options to adjust the

settings to get the best possible image alighment for any given dataset.

l‘.‘w‘-'_' Smart Align X

Data Preparation  Rigid Registration | Non-Rigid Registration I Display I Advance
<Data pre-processing Options>
Apply filter: 'None v
Window data in real-space (Hamming window)
<Registration Method >
Correlation function mode: |Square-root (MCF/0.5) | |0.5
Filter correlation spectra (Butterworth)
Estimate image offsets
(® High S/N data: Consider displacements up to [3_ (< 17) th nearest neighbours
(OLow S/N data: Estimate an average linear displacement

Refine image offsets: I 2 cycles

<Output Options >
Fill the Background
(O with Zeros
(® with Average of other frames
Crop output to common area
Display output in new window (keep original)

Accumulated image: Average v

OK Cancel

The rigid-registration menu is divided into three sections:
Data pre-processing Options

Data Filtering

If the image-series is noisy then image filtering may improve the reliability of the registration.
Two options are available; 3x3 median filtering and 5x5 Weiner filtering. Other advanced
filtering may be used and this special case is discussed with a special example at the end of this

manual.

18
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Data Windowing
For images which have crystal filling the whole field of view, cross shapes often appear centered
on the Fourier spots due to the abrupt edges of the image. These can affect the reliability of the
image correlations and windowing the images in real-space may improve this. A Hamming

window can be selected here.

Registration Method
Rigid registration is achieved in SmartAlign using correlation functions. Three specifically named

correlation functions (between two images g and h) are shown below:
The cyclical cross-correlation:
Corr(g,h) = F"1 (F(g) e F(h)*) (1)

The mutual-correlation function (MCF) (Heel, Schatz, & Orlova, 1992):

MCF(g,h) = F~* (—F(QM(")* ) 2
(g.h) [7(g) < Qo | )

The phase-correlation function (PCF) (Kuglin & Hines, 1975):

_ ot [ F@ormy
PCF(g;h) =F (|F(g)OF(h)*|) (3)

More generally these can be expressed as a continuum set where the exponent on the
normalising denominator, a, is a variable between zero and one (Kuglin & Hines, 1975).
Hereafter, for generality this will be referred to as the normalised correlation function (NCF):

et (@ FGy
NCF(g; h) =F ('F(g)OF(h)*la) (4)

The need to consider modifying the power on the normalising denominator lies in the
range of specimens that may be needed to analysed. For example, specimens with very ‘bland’
crystallography, such as a constant thickness slab of Si[110], will require the registration to be
achieved entirely using the non-periodic information so a larger value of a would be
recommended (say 0.75). However, a free standing metallic nanoparticle free from
contamination can be registered very accurately considering the silhouette of this periodic

information, so a lower value of a would be most suitable (say 0.2).

Finally, if both the images being compared are noisy, the resultant correlation functions can

themselves be noisy and an additional option to filter these with a Butterworth filter is provided.

19
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Once the user has selected which filtering and correlation function options will be used, there
are two further choices; how the offsets will be estimated and whether the offsets will be

refined:

Estimate image offsets
(® High S/N data: Consider displacements up to | 3 (< 17) th nearest neighbours

(OLow S/N data: Estimate an average linear displacement

Refine image offsets: | 2 cydes

Estimating the Image Offsets
Here there are two modes, optimized for both high signal-to-noise (SNR) data and low-SNR data.
For the majority of datasets, the high-SNR mode can be used, and only for the most noisy data is

it necessary to use the low-SNR mode.

Hign SNR Mode:

In the high-SNR mode it is assumed that the correlation functions setup with the previous
options will estimate the offset between images accurately but potentially imprecisely. To
mitigate this the rigid-registration stage of the SmartAlign plug-in does not have rely on any one
measurement to determine the offsets. Instead, when determining the image offsets, each
image can be analysed relative to its direct neighbours in the image series, then its second

nearest neighbours, third-nearest etc.

Here the user can select the number of nearest neighbours to use; the minimum is one, in which
case each image is only compared with the previous one, up to (n-1), where n is the number of
images in the series. To help the user the menu will indicate the maximum number that can be

selected alongside the option.

Increasing this number excessively will increase calculation time with diminishing gains in
precision. Additionally, in the presence of gradual structural changes, such as beam-damage,
including ever further afar neighbours may reduce registration precision. A typical selection

would be three or four nearest neighbours.

The example below shows the result of computing the offsets for the first 4 nearest neighbours.

20
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p
t‘*'_' J: Multi-pair alignment
Horizontal Offsets

m

The figure shows three plots the horizontal offsets between the images, the vertical offsets, and
the similarity between image pairs. Each value is plotted in the lower half (triangle) of the matrix
representing the ith—jth images. The similarity matrix can be useful in determining the number of
nearest neighbours to include, if the similarity begins to drop, this indicates that the images are
no longer similar enough and would not improve (or possibly worsen) the precision of the offset

estimation.

Once the matric of neighbour data is compiled a mutual solution is determined.

Low SNR Mode:

In “Low SNR Mode” the image series data will first be condensed into four subsets to improve
the SNR of low-dose images. The sample drift between image 1 and image 5, should be
approximately the same as between image 2 and image 6, and so on. This gives redundant
observations of the same drift-rate and allows for a more precise estimate to be achieved for

noisy images.

After the four subsets have been analysed to determine the overall drift-rate, the offsets
between these corrected four sets of data are analysed to correct for any shifts induced by any

90° image rotations used.

Together these two information describe all the shifts, the images are realigned and can be

refined as described in the following section.

Importantly, this mode is only applicable to image-series recorded in a single acquisition. If the
series is generated from joining together two or more shorter series, then the prior knowledge

of the monotonic drift behaviour may not be valid and this method will not be suitable.
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Refining the Image Offsets
Using the image-offsets estimated from the previous stage the image series can be realigned.
The average of this realigned series will have a higher SNR than any one image alone. Next, the
user can reanalyse each individual image relative to this average image, and the offsets nay be
able to be improved. This procedure is somewhat iterative and the use can decide how many

attempts should be made to refine the offset estimates.

,:;—_- I: Image offsets E@@
104
04 Ix shift (multi,pair_rigid)l
-10- Iy shift (multi_pair_rigid)l
-204 I x shift (refined) I
-30- I y shift (refined) ]
-40-
-504
-60
-70-
-804
-390
-1004
-1101 !
0 2 4 6 8 10 12 14 16

A typical value might be two refinements; selecting zero will skip this stage.

Output Options

Once the image offsets are refined a new window with the results will be output.

<Qutput Options >
Fill the Background
(O with Zeros
(® with Average of other frames
Crop output to common area

Display output in new window (keep original)

Accumulated image: Average v

Where shifts exist between images there are two choices to output the data; firstly, the canvas
of the data can be expanded to incorporate the image drifts (results in a bigger size image series),

or the data can be cropped to only keep the physical area common to all frames (results in a
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smaller image series). The user can select which option they want with the “Crop output to

common area” checkbox.

If the user selects not to crop the data, they will expand the canvas; in this case there is an
option of what to fill the extra area with. This can be filled with blank (zeros) or it can be filled
with the average of all non-zero observations from that position. The former option is useful for
viewing the image drift and observing changes in the illuminated region of the sample; the latter

is useful for a more ‘panoramic’ option, attempting to maximise the field of view.

In addition to the image series being output, the accumulated image is also shown after
processing. The final option in this section determines whether the average of the frames is

shown, or the summation.

These rigid-registered results can be saved at this point, it is not necessary to continue to the

non-rigid calculation, as this can be resumed at a later time.
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Non-rigid Registration
After finishing the rigid-registration, non-rigid registration can be performed. Before beginning

the non-rigid registration, if it is not already, the results from the rigid registration should be

selected to bring it up as the front window.

i Smart Align X

Data Preparation | Rigid Registration Non-Rigid Registration I Display | Advance

Iterative Registration Cydes:

Initial affine-only cydes: | 2

Advanced non-rigid cydes: | - - select method below:
(® Lock scanrows together
(O Fit rows with polynomial: Linear v

(O Use unconstrained smoothing
Smoothing kernel size(pix-FWHM): I 3

Convergence criterion:  Normal v | | 1.0e-5

Convergence acceleration: Normal v |7.0

Keep NR translation data
Reference Image Choice:

(® Average of all frames
[[Juse nearest neighbour average for first Io— cydes
(O Fixed image I1_ th frame
Output Options:
Display output in new window (keep original)

Accumulated image: | Average @V

oK Cancel

This menu is divide into three sections, with options related to the iterative registration cycles,

the choice of reference image to use, and for the outputting of the result.

The Types of Iterative Registration Cycles

Since the SmartAlign algorithm does not enforce any prior knowledge on the expected
symmetry or appearance of the sample, the registration runs iteratively, converging towards the
ground truth. These iterations are broken into two types and can be selected separately or

together.

24



SmartAlign Plug-in User Manual

Iterative Registration Cydes:

Initial affine-only cydes: |2

Advanced non-rigid cydes: | 4 - select method below:
(O Lock scanrows together
(®) Fit rows with polynomial: Linear v

(O Use unconstrained smoothing

Smoothing kernel size(pix-FWHM): | 8

The first type is to correct the scan-distortion using only affine transformation. This type of
transformation is a ‘linear non-rigid transformation’. Linear, because any straight line feature
before correction will be preserved as a straight line afterwards, and non-rigid because different
pixels can move by different amounts in x and y. Using this type of iteration the user can correct

for image shear, scale, and (small) rotations.

As every pixel in the field of view is used when calculating the affine transform for every frame

(6 parameters), this type of correction is very robust to image noise.

The next type is the “Advanced non-rigid cycles”; these are the fully non-linear non-rigid
iterations. ‘Non-linear’, because now straight lines are no longer required to be preserved.

Unsurprisingly, non-linear transformation is necessary to correct non-linear distortions.

The Number of Iterative Cycles

In the majority of cases few affine type cycles will be required. However, if scan-rotation
between frames is enabled or if the drift rate of the stage is varying over time then more may be
necessary. Fortunately, these affine calculations are computationally very efficient so a default

of say 2-cycles is a good starting value to try in most cases.

The full non-linear calculation is more computationally intensive. For quick calculations to check
the quality of data two cycles may be sufficient. For a more final analysis a typical number might

be four cycles.

Types of Non-linear Cycle
The SmartAlign algorithm offers three types of non-linear iterative cycle. The first of these is the
so-called ‘scan-locked’ mode. This is described in more detail in the SmartAlign academic

manuscript. In brief, this mode maximises the artefact robustness of the algorithm by utilising
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the prior knowledge that the STEM is a scanned instrument. This mode is also applicable for

STM/ADF/SEM etc. For serial microscopes this is generally the most appropriate mode.

In some cases, where the sample is rotating slightly in the plane (not tilting) then row-locking
will not describe this additional motion. For this case ‘row-fitting’ should be used. This allows for
the benefits of row-locking, but also allows an additional degree of freedom to describe the

rotation. A typical use case for this mode might be nanoparticles loosely attached to a substrate.

The final mode available is the fully unconstrained mode. This is most suitable for parallel

acquired data such as conventional TEM and photographic data.

Smoothing Kernel Size

After selecting the type of non-linear cycle, the user must specify a smoothing kernel size.

There are two reasons why a smoothing kernel is used to constrain the diagnosed
transformation fields. Firstly; it is not physically realistic for the diagnosed transformation fields

to contain abrupt discontinuities and so a small smoothing is justified to remove noise.

Perhaps more importantly, and mostly when using the unconstrained (TEM) mode, it is
important that no crystallography is observed in the transformation fields. Remember, the
transformation fields are only a description of the environmental distortions affecting the data.
As the distortions do not depend on the sample under observation, then these should not

exhibit signs of crystal periodicity.

Remember adding a small scan-rotation, and using row-locking will improve STEM (row-locked)

series processing.

Registration Convergence - the Target, Acceleration & Number of Cycles
As the SmartAlign software solves for the image distortions iteratively, success is determined by
the measurement convergence. Three inter-related factors contribute to this convergence

behaviour.

The Convergence Target
The convergence target specifies the exit criterion for the innermost iterative loop. It has units of
the average magnitude of pixel shift in the frame. The preset options range from weak-
convergence (average shift of 10™ pixels) to a strong criterion of 10° pixels. The user can also

specify a custom number.

26



SmartAlign Plug-in User Manual

The Convergence Acceleration
The convergence acceleration determines the aggressiveness of the iterative correction. A
higher number will increase calculation speed but if the number is too high, and the data are
noisy, then the convergence may become unstable. In this case a warning message will be

displayed and the software will attempt to ‘self-heal’ buy reducing the acceleration by 10%.

The weak setting yields an acceleration of 2 through to a value of 20 in the strong setting. The

user can also specify a custom value.

The Total Number of Iterative Cycles
Adding together the number of affine-only and non-linear registration cycles yields the total
number of iterative cycles. The final convergence criterion target specified above is not reached
immediately, but rather the strictness of the criterion is approached gradually and reaches the

ultimate target value at the final cycle.

Storing the Transformation Data

If more than one image signal was acquired, then the probe-offset data can be transferred from
one diagnosis to correct other signals. If this is the case, then the user should check the ‘Keep NR
translation data’ box. When this translation data is stored it is stored in the image metadata for
later use, the data can be used to compensate a second signal immediately, or the file with its
metadata can be saved and the translations used at a later date. In this case the file size will be
larger by approximately a factor of three (the original image data, and two new metadata with

equal dimensions describing the shifts in x and y).

Choice of Reference Image

The user can choose which reference data is used as the comparison image.

Average of all Frames
For the majority of cases the best reference data will be the average of all frames in the series. In
this mode each image will be compared with the average when diagnosing the shifts. At the end

of each cycle the updated frames will be used to make a new average reference image.

Fixed Frame
An alternative to using the average frame is to specify a particular frame to use as the reference

for all others.
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Local Average for Initial Loops
A third choice, for special cases, is to use only the average of the images immediately before and
after each image in the series as the reference — a local average. This local average can be useful
if the image distortions are so large that averaging through the whole series would cause an

excessive degradation in reference image quality.

An alternative use for this local average reference method is the processing of dynamic movies
such as in-situ data, where the underlying sample is genuinely transforming and an average of all
frames would not have a physical basis. In this case some distortion correction is still possible

while maintaining temporal resolution.

Output Options
Here the user can select to open the results in a new window and keep the original open (the
default behaviour). In general, it is only necessary to deselect this in computers with very limited

memory or with very large datasets.

The user can also choose here how to output the compound image after processing. In general,
the ‘average’ image is the most suitable (including for fractional ADF or STM/AFM height data),
but a ‘summation’ image may be useful if the data represents counts or some other quantity you

wish to accumulate.

The Progress Bar
After choosing all the appropriate options, pressing “OK” will start the calculation. During the
calculation a progress bar will be shown, as well as some more detailed text based readouts in

the Output window.

SmartAlign X
Refining image-offset estimates

iteration number: 4

Cancel

The calculation can be aborted if necessary by pressing the “Cancel” button. In this case a

confirmation dialog will be displayed:
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DigitalMicrograph X

e Do you really want to stop processing?

0K Cancel

In this case only the currently running non-rigid calculation will be aborted. The existing rigid-
registered result will remain in the workspace. The NR calculation can be started again, or the

rigid results saved at this point and the calculation continued later.

The NR Outputs and Image Cropping

After the NR registration is complete, and depending on the severity of the drift and distortions,
pixels shifted from outside the scanned area will appear around the edge of the frame as grey
pixels. It may be necessary to crop one or two pixels from around the perimeter. This can be
done by selectin the ROI tool from the toolbar and then selectin the ‘Crop’ command from the

SmartAlign menu.

Aligning Extra Image Signals

After an alignment has been performed (either rigid or non-rigid), then this can be further
applied to another image signal so long as the data were acquired simultaneously. If the data
were not acquired simultaneously then the drifts and probe distortions will not be equal and this

is not applicable.

To do this select ‘Align Second Signal...” from the main menu.

t‘*'_' Align Second Signal X

Reference signal: ' D: Non-rigid Aligned ADF Time Series v

Target signal: | I: ABF Time Series v
Median equalise: Off v
OK Cancel
I
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Here for example the diagnosis from the registration of an ADF series is copied to an ABF series.

After pressing OK, both the new aligned signal will be displayed as well the average of the new

series.

Rigid Registering Additional Signals
In the case of rigid alignment, if the alighment was performed on a reduced ROI, then the user

will be asked whether to use these image shifts for the whole image, or to again return only a

reduced ROI:

i Align Second Signal X

Apply rigid alignment for
(® the same area

(O the whole image

OK Cancel

If the user selects “the same area” then the same area as the ROI used on the first signal is
returned, if the user selects “the whole image” then the whole image is alighed and cropped to

the largest possible common area.

Non-rigid Registering Additional Signals
In the case of NR registration, it is only possible to return the same field-of view, and the above

choice will not be presented.
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Aligning Spectrum Image Series

If the image series which has been alighed represent the simultaneous images frames
accompanying spectrum image acquisition then the probe offsets can be copied from the image

series to the series of spectral volumes.

First all the steps above should be completed; during rigid alignment cropping should be
selected, and during non-rigid registration the option to keep NR translation data should be

selected.

With the alighed image series selected as the front window, select ‘Align SI Data...” from the

SmartAlign menu.

A file explorer window will open and you should select all the spectral volumes that match the
image series. The spectral volume series will be read into DM in the order based on their
filenames. For example adding numbers or letters to the Sl filenames will help them be read

correctly. The example here shows an 8-frame image series and 8 spectrum images selected.

g Align S| Data X

Reference signal: ' D: Non-rigid Aligned 003_HAADF_8frames v

Target signal: 003a_EELS_SI_Ap3mm_fullrange
Selected SI Data: 8
[] trim frames

first frame: | 1
last frame: | 2048

OK Cancel

The size of the spectrum images in the third dimension (number of channels) will also be

displayed, and if necessary a reduced range can be reconstructed to minimise RAM usage.

You should verify that the correct reference data is selected and press ‘OK’.

While the SI realignment and NR registration is running, an integrated spectral view will be
shown as well as an integrated spatial view. These are not interactive and are just visualisations

to monitor the progress. Once complete the corrected spectral volume will be displayed.
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Additional Menu Items

There are two further tabs containing output display options and the advanced settings.

Output Display Options

This tab allows the user to display more or fewer additional diagnostic figures during processing.

t‘*‘-:' Smart Align X
Data Preparation | Rigid Registration | Non-Rigid Registration Display ]Advance

Message Level: Normal v
Qutput figures:
Rigid Registration:
Image offset
Multi-pair alignment
Finding long-range drift
Condensing low-dose data for alignment
Non-Rigid Registration:
Moving image
Reference image
Distortion field

OK Cancel

These options include a choice for the granularity of text message outputs (displayed in the DM

results window) during processing, as well as the additional graphical display of variables.

These settings are saved when the registration is begun and will be preserved after DM is closed

for the next time.

Advanced Options

This menu contains settings that rarely need to be changed.
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i Smart Align X

Data Preparation ] Rigid Registration ] Non-Rigid Registration | Display Advance
Non-Rigid Registration:
max_nr_itts: | 250

[] constrain_edge

pre_smooth_moving: | 1.0
pre_smooth_static: |0.0
noise_constant: |0.4

debug_mode: 0 v

OK Cancel

These options can be used to set an upper limit for the maximum number of iteration per image
in the innermost correction loop. Reducing this number may increase calculation speed but if

reduced too far may stop the calculation from converging fully.

In the case of an image series with a featureless background, then constraining the edges of the

transformation field may improve algorithm convergence.

In the case of very noisy data, a small smoothing can be applied to the individual images or to

the average reference image.

The noise constant controls the robustness to extreme outlier image pixels. A larger number will
increase robustness but at the expense of reduced sensitivity. This number should in general not

be changed.

The debug mode setting is only used for remote support use.
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Special Case Examples

Digital Super-Resolution Example
Consider the example ADF image-series below of a perovskite grain boundary with 16 frames
with 512x512 image pixels each. This has been recorded at high-resolution but with insufficient

pixel-sampling.

e o |[® = B o |[®@ = & = ol <

Enlargement

The FFT shows spots are visible right out to the Nyquist limit, and the highest observable spot is
the (220) spacing (approx.. 1.38A. A 64x64 pixel ROl is enlarged on the far right — again, not how
the sampling is too low. Ordinarily this would be a poor choice of setting to record the image; we
would usually increase the number of pixels or reduce the field of view (increase magnification).

However, both these options would increase the total electron-dose over the sample.

With this data, angle-measurement, structure matching, peak-finding or strain-mapping would
be very challenging. To overcome this, we will increase the sampling of this frame-series in post-

processing using digital super-resolution.

Note: this is not optical super-resolution, it will not extend the resolution beyond that of the
original STEM probe, but rather this is digital super-resolution where the restored image-series

average will contain more discernible information that any one frame at the low sampling.

To do this select “Resample data” in the “Prepare data” menu. For this example, we will use 3x.

Now the data should be rigid, and non-rigid registered as normal.

The results below show the lower-right part of the image after resampling and alignment, the
reduced Fourier transform (central 50%), and a cropped enlargement of the same region as in

the earlier figure above.
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Enlargement

After processing the (331) spot is visible (approx. 0.9A resolution), and the detail in the interface
become clear. The recovered resolution is likely slightly poorer than had the image been

recorded under optimal sampling conditions, but it is an improvement on the raw data.

Note: the data-resampling must be done before the rigid and non-rigid registration to achieve

the digital super-resolution. Doing it afterward would just be a simple image scaling.

Below shows further enlargements of the before (single-frame) and after (average-frame) data.

p
412) [o |[&@ =] D: Cropped Average Through Stack No Aligned 3x Super... [= |[& ][ =]

Going beyond 3x data-resampling will likely offer little benefit and will mostly just add to the

calculation time.
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Processing STM & AFM Data

For many scanned probe microscopy (SPM) datasets, it is often necessary to first remove a
planar ramp background. This tool is provided as a utility in SmartAlign and can be done at any
point. However for best results, it is recommended to perform this step at the start of the data

processing.

With the data loaded and stacked to create a series, select “Remove Image Ramp” from the

main SmartAlign menu:

Acquire...

Setup Stacked Image from Archived Data...

Prepare Data...
Rigid Alignment...
Non-rigid Alignment...

Align Second Signal...
Align SI Data...

- RemoveImageRamp
Crop Data

Show as Movie

Remove NR translation data

Help
About...

If a single image is selected this will operate once, if a series is selected, every image in the series

will have a ramp calculated and removed.

The result will be similar to the example below:
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Note: the range (height data) in the image is preserved, and the ramp is subtracted such that the

new image minimum is zero.

After the ramp removal is complete, you can continue to process the data as usual.
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Advanced Filtering for Rigid Registration
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Troubleshooting

Auto-save function not working with some detector channels.

On some systems you may see the following error when trying to use the auto-saving feature for
some detector choice settings:

DigitalMicrographﬁ

The system cannot find the path
specified.

This is caused when the detector name itself contains a slash ( “/” ) character causing the
filename to try to access a non-existent directory.

To correct this, go to the DigiScan Setup menu, select “Advanced” > “Analogue Input” and edit
the name of the detector causing the error; in this case “Gatan BF/DF” can be changed, for
example, to “Gatan BF-DF”.

DigiScan Configuration

DigiScan Setup

Flip Horizontal Scan
inzgeiidty 1024 Fiyback Time (1s)  1000.0

Image Height 1024 Rotation Offset (deq) 130

Pixel Time () 8.0 20.0 38.8 Maximize Scan Area

Min Frame Time (s) ~ 0.78029 5.7549 41.709
[ Line Sync [ Line Sync [¥] Line Sync Line Synchronization

Integration Integration Sum Frames Line Frequency (Hz) 50
80 % 80 4

[4byte | @ [abyte ]| [4byte  ~]
[4byte v] [4byhe v] abyte  ~
[abyte -] @ [sbyte -] O [apwe” -] DigiScan Analog Input Setup
abyte  ~ 4byte_ abyte ~

4byte . Invert Signal Signal Name Gain  Offset
[JAnaslogd  JEOLADFI  [3500 | [1800

4byte  ~ —
Laer ] [Janslog1  JEOLADF2

[Janalog2  JEQLAB 3500 | 1800

[ J [ cance

ok ) o ] [ oo ]
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